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1 Getting Started - BankRec

Introduction

The goal of BankRec is to assist you in reconciling your corporate accounts – both financial and non-
financial.  Import your General Ledger and your bank statement, and BankRec will match the data and
quickly prepare an exception list. 

This Getting Started guide covers downloading, installing and the basic use of BankRec.

Steps

BankRec Set Up Steps

1. Download and install the software
2. Create and setup accounts
3. Import general ledger files
4. Import bank files
5. Run Automated Transaction Matching
6. Run Reconciliation Report if desired.

Next: Download and install >>

1.1 Download and Install

Download BankRec

Download BankRec from our website at http://www.treasurysoftware.com/download.aspx.   Your
installation password will be sent to your email – be sure you enter it correctly.  When prompted either

http://www.treasurysoftware.com/download.aspx
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save the download file to your computer or run it.

The file is approximately 77 MB (subject to change). 

Install BankRec

After the download is complete, double-click the file to begin installation.    

Next Step

Once the installation is complete, you are ready to use BankRec.

Next: Create and setup accounts >>

1.2 Create and Setup Accounts

Start Bank Reconciliation

Start BankRec by clicking on the Start Button, selecting Programs (or All Programs), selecting
Treasury Software, and clicking the Treasury Software Icon.

The Welcome New Users page will load.  Select the Option for “Bank Rec”

Create Account

Click File>New Account to create an account for your testing.
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Select the option to “Create an Account and Add it to your Catalog” and click Next.
 

Enter a name for the account.  This name is strictly internal and should help you identify the purpose of
the account.  For example, if this account is an operating account, you might call it "Operating".  After
the name is entered, click Next.

You will be prompted to select your accounting.  The default is months.  If you use a different method
of periods, select it as appropriate.  Once selected, click Next.

Congratulations! You have finished creating the account.  Click Finish to begin using this account.  

Next Step

You are now ready to import general ledger data into Bank Reconciliation.

Next:  Import GL Data >>
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1.3 Import GL Data

Obtaining General Ledger Files
Before importing general ledger into Bank Reconciliation, they must be obtained from your accounting
package.  The exact process depends on the package, but in general you will run a check register
report for a given date range and then export this report to an Excel spreadsheet or CSV file.  For
more information or assistance in this, contact your corporate IT.

Importing General Ledger File
Click the the Import GL button on the main screen to start the Import Wizard. 

Click the Open Folder Icon on the General Ledger Import Wizard.

Select your file to Import and click Open.  Common file types are Excel (.xls), Access (.mdb), Comma
Delimited (.csv or .txt), tab delimited (.txt), and text (.txt).

Click Next.

Mapping

The General Ledger Column Mapping screen allows you to specify the purpose of each column. 
Simply highlight a column, and select the appropriate column mapping from the drop down for the data.
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After selecting the Column Mapping, the section about the column names (F1, F2, F3, etc) will switch
from Red to Green and list the selected mapping.
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Repeat for each field that needs to be imported.  Above, Date is mapped to the field containing
transactions dates.  Some common fields for Bank Reconciliation are CheckNumber for check number,
Amount for transaction amounts (alternatively, Debit/Credit if amount is split into two fields), and
Description for transaction description.  See Selecting fields to represent amount for more information
on choosing an amount mapping field.

Once all fields are mapped, click Next.

Review Records
This screen will display a list of the importable rows and invalid rows.  To review the list of Importable
Records, click on the “+” sign as shown below.  

If the “Amount” and “# of Records” columns are correct, click Next and go to Finish.

The grid will display the list of importable checks, and the basic check information.



12

BankRec                                                                                                                                                                                                                  © 2016 Treasury Software

Getting Started - BankRec

The Invalid Rows section will list all rows that will not be imported into Bank Reconciliation.  The
software will automatically mark Header rows, footer rows, summation lines, and blank lines as invalid.
 For each row that is invalid, a check mark will be placed in the appropriate column indicating why the
row was invalid.  In the screenshot below, there were several footer and summary rows which were
automatically scrubbed out, as well as several blank rows.
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Once you have verified the importable information is accurate, click Next.  If you wish to Cancel the
import process and try again, simply hit Cancel.

Click Finish to complete the General Ledger Import Wizard.
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Next Step
The next step is to import your bank data.

Next: Import Bank Data >>

1.4 Import Bank Data

Obtaining Bank Files
Before importing bank data into Bank Reconciliation, it must be obtained from your bank.  Each bank
has different methods and procedures for providing you this data.  Bank Reconciliation's only
requirement is that it be in Excel spreadsheet (xls), comma-delimited (csv), tab-delimited text (txt), or
even fixed width.  It does not matter what order the fields are in internally as long as one of the listed
formats can be obtained.  Contact your bank for more information and assistance with this.

Importing Bank File
Click the Import bank button on the main screen to start the Import Wizard. 
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Click the Open Folder Icon on the General Ledger Import Wizard.

Select your file to Import and click Open.  Common file types are Excel (.xls), Access (.mdb), Comma
Delimited (.csv or .txt), tab delimited (.txt), and text (.txt).

Click Next.

Mapping

The General Ledger Column Mapping screen allows you to specify the purpose of each column. 
Simply highlight a column, and select the appropriate column mapping from the drop down for the data.
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After selecting the Column Mapping, the section about the column names (F1, F2, F3, etc) will switch
from Red to Green and list the selected mapping.
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Repeat for each field that needs to be imported.  Above, Date is mapped to the field containing
transactions dates.  Some common fields for Bank Reconciliation are CheckNumber for check number,
Amount for transaction amounts (alternatively, Debit/Credit if amount is split into two fields), and
Description for transaction description.  See Selecting fields to represent amount for more information
on choosing an amount mapping field.

Once all fields are mapped, click Next.

Review Records
This screen will display a list of the importable rows and invalid rows.  To review the list of Importable
Records, click on the “+” sign as shown below.  

If the “Amount” and “# of Records” columns are correct, click Next and go to Finish.

The grid will display the list of importable transactions, and the basic information on each transaction.
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The Invalid Rows section will list all rows that will not be imported into Bank Reconciliation.  The
software will automatically mark header rows, footer rows, summation lines, and blank lines as invalid. 
For each row that is invalid, a check mark will be placed in the appropriate column indicating why the
row was invalid.  In the screenshot below, there was one transaction marked invalid due to a missing
date.  
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Once you have verified the importable information is accurate, click Next.  If you wish to Cancel the
import process and try again, simply hit Cancel.

Click Finish to complete the General Ledger Import Wizard.
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Next Step
Now that your General Ledger and Bank data has been imported, it is time to run Automated
Transaction Matching to look for exceptions.

Next: Run Automated Transaction Matching >>

1.5 Run Automated Transaction Matching

Matching Overview

After importing bank and general ledger data, you are now ready to use Bank Reconciliation's high-
speed matching system.  

Matching your data is a two-step process.  Step one is to allow Bank Reconciliation to run Automated
Transaction Matching.  It will then match as much of the data as possible based on several matching
rules.  The default rules are check number to check number and amount to amount and void checks to
issue checks within the general ledger.  There are several other rules available off-the-shelf that will
satisfy most needs.  Once that is completed, step two is to review the remaining unmatched records
and make manual matches as necessary.  

Run Automated Transaction Matching

To run Automated Transaction Matching, select "Matching" from the top menu, then select "System
Matching (Automated Transaction Matching)".  Matching will start immediately.  A box will be displayed
confirming that matching has started.  Depending on the amount of records, the box may not be visible
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for very long, but it will always remain visible as long as matching is in progress.  Very important: once
started, do not switch out of Bank Reconciliation until the process completes.  

Run Manual Matching

With System Matching complete, it is now time to look for manual matches.  Select Matching from the
top menu, then select "Manual Matching".

Depending on the success of System Matching, you may have very few records or you may have quite
a lot.  In either event, check through the data looking for matches that were missed by the system. 
Misses can occur for several reasons and is usually directly attributable to the cleanliness of the data.  

In the screenshot above, there is 1 match that can be done manually.  On the bank side is a Funding
Credit on 2/19/2008 for $16,750.00.  On the GL side are two records, one for $17,000 to NY #620 and
the other is an adjustment to NY #620 for -$250.00.  Clearly these two sum together to equal the bank
record and are a match.  To match them manually, select the relevant records.  To select multiple
records on a side, hold the Control key while selecting records.
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You can see at the bottom that each side has $16,750.00 of transactions selected and the difference
(in the box above Match Bank to G/L) is $0.00.  To match, click the "Match Bank to G/L" link.  This will
match the records and remove them from the unmatched list as you can see below:
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At this point we can continue moving through our data looking for additional matches.  Since there are
no more, we have now completed the matching process.  To exit this window, click the red X in the
upper right corner of the screen.

Next Step

With all your matching completed, it is time to review the exception list.  This will provide detailed
information on all unmatched records to aid you in researching your high-risk items.

Next:  Getting Exception List >>
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2 Imports

Overview

Importing is the process to bring data into the program.  For Bank Reconciliation, there will be at
minimum two imports, one for bank data (or data external to your company) and one for general ledger
data (data internal to your company).  For Bank Reconciliation, you will only be importing general
ledger data, specifically checks.  

Required

Before importing it into Bank Reconciliation the data must exist in tabular-formatted source files.

Importing the data

You are free to use any or all of these methods for importing data. 

Importing source files

Use one of these methods when all data is contained in source files.
See Importing Bank Data and Importing General Ledger Data for information on each of those imports.

Entering records manually

You would import manually when you need to add transactions not contained in a file. This saves you
from having to create a file just to import the records. By its nature, manual imports are for very small
numbers of transactions.  It is far faster to use a file import.

See Entering Data Manually for more information

2.1 Importing Bank Data

Importing Bank Data

In this section, you will learn:
· How to import data from your bank into Bank Reconciliation

Required
Before continuing, you must:

1. Have data from your bank in a file or multiple files in tabular format.
2. Be working in the proper account.

Overview

Obtain a copy of your bank transactions in a usable file format - Excel spreadsheet, comma-separated
values (CSV), tab-delimited, etc). 

Every bank uses its own format to order the data fields.  Fortunately, Bank Reconciliation will handle
any source file as long as it is in a tabular format.

Steps To Import Data
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1.  From the Home Screen, click the Import Bank button.

This will load the Bank Import Wizard (Figure 2 below).



27

BankRec                                                                                                                                                                                                                  © 2016 Treasury Software

Imports

2.  In the wizard, you can either:
· Browse to a saved file by clicking the folder icon (Figure 2 above)
· Copy data from Excel and paste it into the grid a the bottom of the screen.

Note: It is best practice to import a saved file.  

When finished, click Next.

a. If the file was an Access database:
The Select a Table dialog box (Figure 3 below) is displayed. 

b.If the file was a multi-sheet Excel spreadsheet
The "Select a worksheet or range" dialog box would be displayed.

Choose the proper table or sheet and click Next.
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Figure 3- Select a Table dialog box

You will now be at the Bank Column Mapping dialog box (Figure 4 below).  
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Figure 4 - Bank Column Mapping dialog box

At this point the import process is not yet complete.  The data which has been brought into Bank
Reconciliation must be mapped to identify each field to Bank Reconciliation.  

Note:  The data only needs to be mapped once.  Bank Reconciliation automatically remembers your
settings. 

Next Step
Mapping Bank Data  

2.2 Importing General Ledger Data

Importing General Ledger Data

In this section, you will learn:
· How to import data from your general ledger into Bank Reconciliation

Required
Before continuing, you must:

1. Have data from your accounting system in a file or multiple files in tabular format.  
2. Be working in the proper account. See Creating a new account or Switching to a different account

Overview
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The general ledger contains a record of all financial transactions by a business.  Everything that affects
an organization's balance will be listed in the general ledger.

This data typically resides in your accounting system.  Before importing, it must be exported from the
accounting system to a tabular-formatted file. Alternatively, you can use any report writer to achieve
the same result.  

Steps

1.  From the Home Screen, click the Import General Ledger button.

This will load the General Ledger Import Wizard (Figure 2 below).

2.  In the wizard, you can either:
· Browse to a saved file by clicking the folder icon ( Figure 2 above)
· Copy data from Excel or other program and paste it into the grid a the bottom of the screen.

Note: It is best practice to import a saved file.
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When finished, click Next.

a. If the file was an Access database or multi-sheet spreadsheet:
The Select a Table dialog box (Figure 3 below) will be displayed.

b. If the file was an multi-sheet Excel spreadsheet,
The "Select a worksheet or range" dialog box.  The intention is the same.

Choose the proper table or sheet and click Next.

Figure 3 - Select a table dialog box

You will now be at the General Ledger Column Mapping dialog box (Figure 4 below).  
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Figure 4 - General Ledger Column Mapping dialog box

At this point the import process is not yet complete.  The general ledger data which has been brought
into Bank Reconciliation must be mapped to identify each field.  

Note: The data only needs to be mapped once.  Bank Reconciliation automatically remembers your
settings.

Next Step
Mapping General Ledger Data

2.3 Entering Data Manually

Entering Data Manually

In this section, you will learn:
· How to manually enter records (both bank and general ledger)

Overview

The majority of the time, your data (either bank or general ledger) will be contained in source files that
will be imported as an entire file.  This is efficient and accurate as it involves no data entry and the data
is obtained directly from a bank or accounting system.

In some situations, however, you may need to import transactions manually.  

Steps
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1.  At the Bank Reconciliation select Add a Record from the Home tab.
2.  Select Add Record(s). You will see the screen in Figure 1 (below).

In the dropdown box, you see listed the type of import.  In this case, the check will go into General
Ledger data.  To import into Bank data, change the option in the dropdown box.

3.  Fill out each of the fields with the appropriate data.  Every field is required. 

Regardless of importing a check as general ledger or bank:
ü Enter voided checks as positive values (only general ledger)
ü Enter issued checks as negative values

When finished, click OK.

4.  For each check you need to add, repeat steps 1 through 3.

5.  Click OK.

Related Topics

Deleting a record to delete a single record.
Deleting an entire import to delete all records from a file import.

2.4 Deleting a record

Deleting a record

In this section, you will learn:
· How to delete a single record from Bank Reconciliation (either bank or general ledger record)

Overview

Follow these steps to delete a single record, regardless of whether it was entered manually or
imported in a file with other records.



34

BankRec                                                                                                                                                                                                                  © 2016 Treasury Software

Imports

1.  From the Reports tab select All Reports and select All Records.
2.  From the top menu select Actions then Delete record(s).

3.  Once the record is highlighted, click the red X in the toolbar to delete the record (Figure 2 below,
Delete button circled).
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4.  A dialog box will be displayed to confirm the deletion.  Click Yes to delete, No to cancel and retain
the record.

Related Topics

See Deleting an import to learn how to delete an entire file.

2.5 Deleting an import

Deleting an import

In this section, you will learn:
· How to delete an entire imported file from Bank Reconciliation

Overview

Follow these steps to delete an entire file import

1.  From the Home menu, Delete Entire Import
2.  The Report Creator will load the "Import Logs" report (Figure 1 below).
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This report is grouped by Bank or G/L.  You can see all the files imported, including date of import,
location of import, number of records, and subtotal of amounts.  This helps you distinguish the files to
ensure the correct one is deleted.  

3.  To delete a file, click the record to highlight it in blue. Then click the red X, the Delete button, in the
toolbar.  Figure 2 below shows the highlighted file and the delete button.

In Figure 2, all records imported in Feb_GL.xls on 1/03/2013 will be deleted when you click the Delete
button (Step 2 above).

4.  A dialog box will be displayed to confirm the deletion. Click Yes to delete, No to retain the records. 
You may perform further deletions if you wish.

Note: If any of the records have been matched, Bank Reconciliation will unmatch them.

Related Topics

See Deleting a record to learn how to delete a single record.

2.6 Importing/editing in a Reconciled Period

Importing/editing in a Reconciled Period

Once you reconcile a period, the system locks down that period and all periods before it - as
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reconciliations are a history-to-date report.

In order to add, edit or delete records in a reconciled period (or prior to a reconciled period), you must
unmark that period as being reconciled.

How to unmark a period as being reconciled
Form the Reports tab > All Reports > select Periods from the drop down list and click 'Run'.

Then select the period to be unmarked and click on the Report Submenu 'Actions' > 'Unmark Period as
Reconciled' 



38

BankRec                                                                                                                                                                                                                  © 2016 Treasury Software

Imports

Remember: All periods prior to (earlier) than a reconciled period are considered reconciled as well.

Reconciling a Period
Tip:  Did you have to unmark several periods to work on a period?
To mark them as reconciled, start with the earliest one that was reconciled, and run a Reconciliation
Report.  This will mark the period as reconciled.
Then run a report for each subsequent period until you have finished.
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3 Mapping Your Data

Mapping Overview

Bank Reconciliation conforms to your data, not the other way around. In the mapping process, you tell
Bank Reconciliation what each field of your data represents. This process only needs to be performed
once for each unique layout of your data. 

 You can use the default template or one of the other 'user-defined' mapping templates.

Before You Begin

Required:

1. You have created your own account (not using the Sample account).

2. You have already imported your bank or general ledger data.

3.1 Deciding What to Map

Why do I need to map the data?

Mapping translates your internal data name into a name the software knows.  Without this step, the
software will not know, for example, if a field holds transaction date or check number. 

Choosing fields

For the majority of cases, the mappings below are suggested.

Bank Reconciliation

At a minimum, positive pay files sent to the bank will include: check number, amount, date, usually the
payee name, and sometimes a void indicator.  Perform these mappings as follows:

Field From Data Bank Reconciliation field

Check number CheckNumber

Amount If amounts in file are positive and all
checks are issued checks -
Amount_Reverse_Sign

If amounts in file are negative and all
checks are issued checks - Amount

If amounts in file are both positive and
negative but signed correctly - Amount

Date Date

Payee name Description

Void check indicator Void_Check_Indicator
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See Mapping General Ledger Data for the steps to actually create the mapping.

Bank Reconciliation

In Bank Reconciliation, you will have two kinds of data: bank data and general ledger data.  For the
most part, you can follow the guidelines listed above for Bank Positive Pay.  However, you must pay
special attention to how the amounts are listed.  In some cases, the bank data will have two columns,
one marked Debit and one Credit, while other times the amounts are in one field and signed.  Special
care must be taken as positive and negative values have different meaning to the bank than to your
company.  

For Debit/Credit mappings, please see Debit versus Credit.  

For amounts in one field, it is important to know that Bank Reconciliation views all negative values as
being ones that reduce your general ledger, such as payments and issued checks, while positive values
increased your general ledger, such as deposits and void checks.  If this is accurately represented in
the bank data, map the amount as Amount.  If the signs are exactly the opposite, map the amount as
Amount_Reverse_Sign.  See Selecting fields to represent amount for more information

More Resources

For definitions of the available fields, see Definitions - Mapping Fields

To learn how to map the data, see Mapping Bank Data and Mapping General Ledger Data

3.2 Selecting fields to represent amount

In this article, you will learn:
· How to choose the proper Bank Reconciliation field to represent dollar values

Required
· Review Debit versus Credit

Overview

Bank Reconciliation requires four fields be mapped for any imported data: Date, CheckNumber, and
Amount. However, Amount really refers to a category of fields that can be mapped for this purpose. 
These fields are:

1. Amount
2. Amount_Reverse_Sign
3. Amount and Sign
4. Debit and Credit (always mapped as a pair)

In making the selection, the main criteria is: Do these values have the correct sign? In other words, if all
the transactions have positive amount values, do all of them increase the account balance? If some
decrease the balance, are they negative values? If the answer to both is yes, Amount is probably the
right choice. If no, you should explore the other options. 

Amount

Choose Amount when data in a file is both positive and negative. 
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However, the following must be true about the data:  
üPositive increases the account balance
üNegative decreases the account balance

For example, if you are mapping bank data, debit transactions (voided checks and deposits) must be
negative and credit transactions must be positive. 

If true, map the field as Amount

Amount_Reverse_Sign

Amount_Reverse_Sign is exactly the opposite of Amount: it will reverse the sign of the data when it is
imported. This can be necessary if the transactions that should increase an account balance are
negative values in the file and vice-versa. 

For example, if you are mapping bank data, debit transactions (voided checks and deposits) should be
negative and credit transactions should be positive.  If they are reversed, map this field to correct the
sign instead of having to manually edit the data outside of Bank Reconciliation and then import it.

Sign

The Amount field includes both the value of the transaction (how much money) as well as the sign of the
data (positive or negative).  In some situations, the source data will provide you with amounts that are
all absolute, but a second field will tell you the sign of the data.  For example, a data file might look like
the following:

67.22 credit
41.14 credit
99.18 debit
56.10 debit

Map the first column as Amount and map the second column as Sign. 

In the second column, the word "credit" identifies a transaction that should be treated as a credit
transaction and "debit" identifies a debit transaction.  See Debit versus Credit for more information. 

By default, Bank Reconciliation uses "debit" and "credit" as the text identifying those respective
transactions. See Changing debit and credit text to enter text identifiers specific to your data.

Debit and Credit

Debit and Credit are used when the source data splits the amounts into two separate fields, one for
debit transactions and one for credit transactions.  This effectively splits the data into what should be
positive values and negative values. 

By default, Bank Reconciliation interprets the text "debit" and "credit" as referring to those respective
transactions.  See Changing debit and credit text to enter text identifiers specific to your data. 

For more information on debit and credit as they relate to sign, see Debit versus Credit. 
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3.3 Mapping Bank Data - Bank Reconciliation

Required:
· At this point, you have followed the steps in Importing Bank Data to import bank data into Bank

Reconciliation.  

Suggested:
It is recommended that you have read the Mapping Overview and Deciding What to Map articles

If you need more information on a particular field, please Definitions - Mapping Fields

Mapping Bank Data

At this point, you have a screen similar to Figure 1 (data in grid will be different).

Figure 1 - Bank Column Mapping dialog box

This file contains 7 fields (columns), as listed by the column header in the grey box.  They are:

· Date · Amount

· Bank ID · Currency (not visible)

· Account ID · Transaction Type (not
visible)

· CheckNumber

The topmost row has green and red headers. Date, CheckNumber, and Amount are in green
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while the red boxes have no label.  Green means mapped. Red means not mapped.  In the movie
below, you can see how to map those  same 3 fields from start to finish.

To map:
1. Click on the red header. 
2. In the dropdown, select the appropriate entry

The header will turn green and the field name will be displayed inside. 

To unmap:
1. Click on the green header
2. In the dropdown, choose "Select..."

The header will turn red and the field name will be removed.

How do I know which field names to use?

Look at the data in the movie above.  Each column is labeled with internal field fields.  Of these, five
correspond directly to a Bank Reconciliation field while the others can map to a text field if you need to
retain them.

Internal
Field

Maps As Bank Reconciliation Field



45

BankRec                                                                                                                                                                                                                  © 2016 Treasury Software

Mapping Your Data

Date Date

Check
Number

CheckNumber

Amount Amount

Transaction
Type

Description

Bank ID Text1

Currency Text2

Account ID Text3

Which fields do I map?

Outside of the required fields, you are free to map as many or as few fields as you wish. These
decisions are affected greatly by your situation and how much data you wish to retain later in the
matching process.  Note that including additional fields does not guarantee increased matching
accuracy. You should assume that any fields you include are solely for your benefit later.

Here is one way for the above data:

1.  Map all required fields (Date, Check Number, Amount)
2.  Map all fields you wish to retain (Transaction Type as Description)

Next Step

If you have more Bank data to import, or have not yet imported General Ledger data at all:
Importing General Ledger Data

If you have already imported all General Ledger data and you have no more Bank data:
Matching Your Data

3.4 Mapping General Ledger Data - Bank Reconciliation and Bank
Positive Pay

Required:
· At this point, you have followed the steps in Importing General Ledger Data to import general

ledger data into Bank Reconciliation.  

Suggested:
It is recommended that you have read the Mapping Overview and Deciding What to Map articles

If you need more information on a particular field, please Definitions - Mapping Fields

Mapping General Ledger Data

At this point, you have a screen similar to Figure 1 (data in grid may be different).
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Figure 1 - General Ledger Column Mapping dialog box

This file contains 7 fields (columns), listed by column headers in the 3rd row.  They are:

· Date · Description (partially
visible)

· Journal · Debit (not visible)

· Journal ID · Credit (not visible)

· Document #

The topmost row has green and red headers. Date, CheckNumber, Debit, and Credit are in green while
the red boxes have no label.  Green means mapped. Red is not mapped.  In the movie below, you can
see how to map those same four fields from start to finish.
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To map:
1. Click on the red header. 
2. In the dropdown, select the appropriate entry

The header will turn green and have the field name inside. 

To unmap:
1. Click on the green header
2. In the dropdown, choose "Select..."

The header will turn red and the field name will be removed.

Next Step

If you have more Bank data to import:
Mapping Bank Data - Bank Reconciliation

If you have already imported all General Ledger data and you have no more Bank data:
Matching Your Data



Matching - BankRec
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4 Matching - BankRec

Overview

Matching is the process that pairs a bank record with a general ledger record (or sometimes multiple
records).  For example, a cleared check on the bank side is matched with the issued check on the
general ledger side.  These records are either time-based exceptions (a deposit in transit or an
outstanding check, both of which will have a match once enough time passes) or permanent exceptions
that should trigger an investigation. 

What Creates a Match

Matches are created based on attributes. For example, check number to check number and amount to
amount is a very basic two-attribute match used for checks.  For more information, see Types of
Matches

Bank Reconciliation makes one pass through the unmatched records looking for matches for each set
of matching rules turned on.  For example, by default, check to check, void to issue, and non-check are
turned on.  Bank Reconciliation will attempt to match the data using three separate passes.  It will
apply the check to check rules for the first pass, void to issue for the second pass, and non-check
matching for the last pass.  

Unmatched records remaining after system and manual matching is rolled forward to the next period.

Matching Processes

Bank Reconciliation performs two kinds of matching:

1.  System Matching (also called Automated Transaction Matching)
2.  Manual Matching

System Matching

When activated, Automated Transaction Matching matches bank records to general ledgers in a high
speed process.  

Records can remain unmatched for a variety of reasons, such as:

· Unrecorded bank transactions (interest, fees)
· Items that have not cleared the bank (outstanding checks, deposits in transit)
· Disputed items
· Possible fraud items
· Bank records that need multiple general ledger records to create a match
· Non-check records with date outside the set range
· Transactions with site number on one transaction but not on the other

Of these, Bank records that require multiple General Ledger records can be matched manually.  The
others cannot be matched with the currently imported data and using the current date range.

See Performing System Matching to learn how to start the process.

Manual Matching

The Manual Matching windows displays a list of all unmatched records (bank records on left side,
general ledger records on right side).  
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Using a point-and-click interface, you can match records on a one to one or many to many basis.

See Performing Manual Matching to learn how to match records by hand.

4.1 Types of Matches

Overview
The Automatic Transaction Matching process is a series of matching passes (also called rules or
subroutines). These passes can be turned on or off to fit your particular situation. 

Matching rules
From the home page - click on the matching options icon in the lower right corner.
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By default, Check to Check, Void to Issue, and Non-Check matching are on and Many to Many and
Alphanumeric Matching are off.  

4.1.1 Check to Check

Check to Check Matching

Default: On
Possible Settings: On or Off
Attributes: Records are matched using check number and amount.

The match will be a cleared check from the bank to an issued check on the general ledger.

Sign of the checks must be the same (negative to negative).  A cleared check will not match a voided
check, even if the amounts and check numbers are the same as the signs will be different.

Exceptions Generated

Cleared check on bank side without corresponding entry on general ledger is marked "Check Cleared
bank, no G/L record" (Exception #310)

Cleared check on bank side already matched against the general ledger (regardless of amount) is
considered a duplicate clearing check and is marked "Check cleared more than one" (Exception #115)

Cleared check on bank side matched an entry in the general ledger, but the amounts do not match is
marked "Bank amount differs from G/L amount" (Exception #110) on bank side and "G/L amount differs
from Bank amount" (Exception #210) on general ledger side.

All remaining issued checks are marked as Outstanding Checks (Exception #498). 

4.1.2 Void to Issue

Void to Issue Matching

Default: On
Possible Settings: On or Off
Attributes:  Records are matched using using check number and amount from void check to same
fields of issued check. Records are general ledger to general ledger.

This type of matching occurs solely in general ledger data.  A check number and amount of an issued
check will be matched to a check number and amount of a voided check.

Voided check amounts should be positive; issued check amounts should be negative.

Exceptions Generated

A voided check with no corresponding issued check is marked "Voided check, no record of
issuance" (Exception #410)

A voided check with a corresponding issuance that has already been matched (to a cleared check or a
previously voided check) is marked "Voided check duplicate" (Exception #415)

A voided check with a corresponding issuance but differing amounts is marked "Amount on issued
check differs from amount voided" (Exception #420/#425)
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Note: All unsuccessful void to issue matches are considered to be high risk exceptions

4.1.3 Alphanumeric

Alphanumeric Matching

Default: Off
Possible Settings: On or Off
Attributes:  Reference code in Matching_Field or Text1 and amount
Note: To use Alphanumeric Matching, you must turn off Non-Check Matching. See Note at bottom.

Alphanumeric Matching uses either Matching_Field or Text1 as a unique reference field to match
records.  Either field can be mapped for this purpose, but Bank Reconciliation will not allow you to map
both (this would be the same as giving the same name to two entirely different things).  Each non-check
transaction on the bank side is matched to a similar record on the general ledger using the reference
code and amount.

For a match to be successful, both records must have the same reference code and contain equal
amounts. Both amounts can be either positive or negative. In addition, the records may not contain a
check number, and the reference code should be at least one character long. 

Records with a check number are not matched using this process.  Checks are matched in the Check
to Check and Void to Issue processes.  Also, records with no entry in the reference field will by
definition not be matched by this process.

Note: 

Non-Check Matching must be turned off or the matching by the Non-Check pass will mark these
records according to those rules and not apply Matching_Field as a match attribute. See Non-Check
Matching for information on non-check rules. See Types of Matches for instructions on toggling the
matching options.

4.1.4 Alphanumeric 2 and 3 field matches

The Alphanumeric 2 and 3 matching rules operate similar to the Alphanumeric matching rule, but add
additional fields.
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Alphanumeric 2 matching rule matches Bank to G/L records based on an exact match of the following
fields:
--Amount
--Text 1
--Text 2

Alphanumeric 3 matching rule matches Bank to G/L records based on an exact match of the following
fields:
--Amount
--Text 1
--Text 2
--Text 3

General notes:
--It does not matter which field is mapped text 1 vs text 2, etc...
--Use 'Text 1' (not 'Matching Field') to map your first field. 
--There must be a value (no blanks) in each of the fields text fields mapped in order for them to be
matched.
--If you have three text fields to match - of course use Alphanumeric 3.  Do not also use Alphanumeric
2, as it would then ignore the third field, and give you unintended matches.
--If you have more than three text fields to base a match on, we suggest concatenating the data prior
to importing into Bank Reconciliation.
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4.1.5 Non-Check Matching

Non-Check Matching

Default: On
Possible Settings: On or Off
Attributes:  Records are matched using using amount, site number, and that the records are within the
data range

Transactions are grouped on the Bank and G/L by site. If site is not used, all sites are grouped into the
default site group (0). 

For each Bank record, the system looks for an equal amount on the G/L side. It then qualifies the
record(s) by examining the business days (weekdays) between the two dates. See Adjusting the data
range for information on modifying the range.

If multiple Bank transactions satisfy multiple general ledger transactions, both sides are matched
sequentially in ascending date order.

Without matching on the group number, there is a possibility of a false positive match. For example,
two deposits are made on the same day, one in the morning, one in the afternoon, each for $100. The
bank clears one deposit (made in the morning) the next day, while the afternoon deposit clears two
days later. Bank Reconciliation may cross match the deposits, as the general ledger deposit date was
the same.

However, if the bank deposits were on sequential days the system would not cross match the records
as the system would work with records in an ascending date order on both sets of data.

Exceptions Generated

Unmatched Bank records are marked either "Unrecorded bank deposits" (Exception #335) or
"Unrecorded bank withdrawals" (Exception #340).

Unmatched general ledger records which decrease the account balance are marked as '"General
ledger reduced, no bank entry" (Exception #230).

Unmatched general ledger records which increase the account balance are marked either "Deposits in
Transit" (Exception #240) or "Missing Deposit" (Exception #220).  The exact exception generated
depends on the date range. 

4.1.6 Out of Balance Matching

Out of Balance Matching

Typically, matches are 'in balance', meaning that the sum of the Bank records equals the sum of the
General Ledger records, within a match group.

However, there are times when records need to be matched, but they are out of balance.  

The most common scenarios are when:
--cash is deposited at a retail location (internal G/L records), but when the bank counts the deposit, it is
slightly different, and
--when credit card fees are calculated - but there are minor differences in merchant fees (card not
present, card classification, etc...)



55

BankRec                                                                                                                                                                                                                  © 2016 Treasury Software

Matching - BankRec

Note: If you don't want to allow out of balance matches, simply do nothing (see below).  If your users
need to match records, they can 'Add a Record' and then include this added record within the match
group.

Out of Balance matching is available once you've migrated from our trial desktop to either SQL Express
or SQL Server.

Specifying an allowance (tolerance)
In order to use this feature, you must first specify an allowance.  Settings > 'Import, Matching, System'
> Match.  
Below we entered $1,000 as our allowance (of course, your allowance will differ).

Creating an Out of Balance Match
1. Select the records in the Matching Window, and then click in the lower left corner.
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2. Confirm
You'll receive a confirmation pop-up as below. Click OK.
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3. Select the 'type' of out of balance matching.

The top selection just adds the balancing record (enabling the system to match).
The bottom selection adds the balancing record plus an offsetting record.

Example
For example, if the bank deposit was $100, and the G/L record was $99 - the balancing record will be
$1 on the G/L side in order for the system to match it.

If you're using the top selection:
If you then go ahead and create a journal entry in your accounting system for $1 to increase cash by $1
- and then import it into Treasury Software - the $1 journal entry will remain as an unmatched item. 
There is nothing to match it to.
In addition, if you are using our reconciliation report - you'll have more activity for the period and be out
of balance (beginning balance + activity <> ending balance).

However,  if you selected our Bottom selection:
It will avoid this situation, as it will also create an 'offset' record.
The 'offset' record is the offset of the balancing record.  Here the balancing record of $1 (positive),
would have an offset record of -$1 (negative).

Therefore, in this example - when the journal entry of $1 (positive) is imported into Treasury Software:
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--it can be matched against this offset record (a G/L +$1 with a G/L -$1), and
--the net activity is $0 - and therefore will not change the reconciliation report.

How do I know which option to use?

Golden Rule
If you will be making a journal entry for the out of balance record into your accounting package
- and then importing it into Treasury Software - you will want to use the bottom selection.

If the above scenario sounds familiar and you're importing your journal entries to account for out of
balances - use the bottom selection.
Otherwise, please use the top selection.

Tips for use with the Reconciliation Report
I'm out of balance - and I used the bottom selection - what happened?
The bottom selection will not cause an out of balance condition.  However, if you created a journal entry
in the same period - and imported that into Treasury Software - please remember to update your new
ending balance for the General Ledger (you just updated it! - there's a new ending balance) at the
Reconciliation Report.

4.2 Performing System Matching

Overview

System Matching, also called Automated Transaction Matching, uses a high-speed matching engine to
pair a bank record with a general ledger record.  

Following System Matching, you will do Manually Matching to pair bank records that required multiple
general ledger records to create a match.

Steps

1.  From the Bank Reconciliation Main Home tab, click the Matching Windows button.
If you are using a version prior to 2013 click the Match Records button located in the Bank
Reconciliation Main Screen.

If you watch quickly, you will see the progress of the Automated Transaction Matching. 

Alternatively, you can select Matching from the top menu, then System Matching and this will do exactly
the same thing as the steps above.

You will now see the Manual Matching screen (Figure 2 below).  System Matching with all imported
data has been completed.  The records currently remaining are unmatched.

Next Step
Manually Matching
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4.3 Performing Manual Matching

Overview

Following Automated System Matching, you should check the data to ensure all records are matched
that should have been matched.  

Steps

Following System Matching, you will see the screen in Figure 1 (below).  The data will be different as it
will reflect your data.

The left pane holds bank records, the right pane holds general ledger records.  Look through the data
in each to see if there are any matches.  

In Figure 1 (above), the bank side has a Funding credit on 2/19/2001 in the amount of $16,750.00. 
Look on the general ledger side.  There is what appears to be a deposit listed as NY #620 for
$17,000.00.  Right below it, there is a record for - $250.00, listed as NY #620 Adjustment. Clearly the
intent is to make the NY #620 deposit for $16,750.00.  This matches the Funding Credit record on the
bank side.  These 3 records (1 bank, 2 general ledger), are a match.  Follow these steps to manually
match these records.

1.  Select each of these records by clicking on them (to select multiple records in the same pane, hold
Control).  They will not be highlighted in blue (Figure 2 below).
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In the bottom of the screen, notice that you see $16,750.00 in the text boxes corresponding to each
pane.  The difference between the two, $0.00, is in the middle textbox.  To match, click the "Match
Bank to G/L" link.  The system will match the records and remove them from the screen (Figure 3
below).

Scan through the data again.  There are no more matches.  Click "View Easy Steps - Home" to go
back to the Main Screen.

Next Step

The next step is to run reports on the matched and unmatched records.
See Reports

4.4 Unmatching records

Unmatching records

To unmatch records, run a report that displays at least one member of the match group that you want
to unmatch.  

1. From the Reports window run one of the following reports:
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All Records
Bank only
G/L only

2. Select at least one member of the matched group that you want to unmatch.

3. Click on the unmatch icon (looks like a dark blue 'undo' arrow) from the Reports toolbar.

The records are now unmatched.

If the records were matched by the system (Automated Transaction Matching)
When you enter into the Reports window - or the manual matching window - the system will re-run the
Automated Transaction Matching process again (by default).

If you do not turn off the default behavior, the system will simply rematch the records - undoing the
work you've done in steps #1 through #3 above.

To turn off the ATM process, from the top menu select Settings > Import,System > Match tab.
Change the options below as needed.  
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Notes:

--If you turn off the ATM (per above), you can always run ATM from the main window.

--If you manually matched the records, you do not have to turn off the ATM to prevent them from being
matched.
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--If the account has reconciled periods, the unmatched records can not be in a reconciled (or earlier)
period.



Reports



65

BankRec                                                                                                                                                                                                                  © 2016 Treasury Software

Reports

5 Reports

Required
· You have imported bank and general ledger data
· You have matched the data (using either System or Manual Matching, or both)

Overview

Reporting is the last step in using Bank Reconciliation.  In this step, you will run reports describing your
data, both matched and unmatched records, to speed up the process of using the data for
reconciliation and making it easier to see exceptions.

Loading Report Creator

To view the Report Creator click on the View tab then All Reports.
If you are using a version prior to 2013.  There are two ways to load the Report Creator.  You can
select Reports from the main menu or click the Reports button on the Main Screen.  The Report
Creator will load.

In the top left corner is the report selection dropdown box.  In this box you can select the report you
wish to view.  The reports are broken into 3 categories:

· Record Listings (list all records, just bank records, or just general ledger records)
· Reports... (create a variety of reports on matched and unmatched data)
· Other 

If you are unsure which report to run, see Commonly used reports.

See Toolbar Buttons for more information on each button on the toolbar.
See Commonly used reports to learn about popular reports.
See Grouping data to learn how to group data on different fields.
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5.1 List of Reports

Bank Reconciliation contains a number of reports available for your use. These reports include the
following:

· All Records
   Show all records for a given date range
· Bank Only
   Shows all bank records for a given date range
· GL Only
   Shows all GL records for a given date range

· Unmatched items (period sensitive)
Show all unmatched items through the period ending date.

· Unmatched items (thru current)
Show all unmatched items

· Unmatched w/o OS checks
Show all unmatched items except for outstanding checks

· Matched only (grouped)
Show all matched record (grouped by audit trail number)

· Outstanding Checks
Show all outstanding checks

· Periods
Show period ending listings, including whether period is reconciled and the ending balance

· Import Logs
   All files imported into the system by type (GL or Bank).  Includes record counts, total imported
amounts, and date range
· Manually Added Records
   Only transactions that were manually added through the Add Record function
· All Records (All Text Fields)
   Similar to All Records, but displays all optional text fields
· Bank Statement Summary
   Displays bank statement for selected period
· Bank Statement Detail
   Similar to Bank Statement Summary, but can be drilled into for more information
· GL Statement Summary
   Displays GL statement for selected period
· GL Statement Detail
   Similar to GL Statement Summary, but can be drilled into for more information
· Balancing Entries
   Entries created by the system during reconciliation to correct an out-of-balance

Through a combination of grouping and filtering, it is possible to obtain a very customized report which
can then be exported to Excel for later use or import into another system.

See Grouping data to learn how to use different data groupings within the report (change data view)
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5.2 Toolbar Buttons - Reporting

At the top of the Report Creator is the toolbar (Figure 1 below). Each button in the icon offers quick
access to features common for working with reports.

Running a report
In the upper left, change to a different report by using the dropdown box (currently reads "Select a
Report").

Changing date range
Select the appropriate date range from the dropdown box.  Some reports are period-sensitive.  If so,
change the system period by clicking "Current Period - 2/29/2008" (will display current period ending
date selected, in this case 2/29/2008)

Saving a report layout
If you will repeatedly use the same report on similarly-formatted data, you can save the exact field
groupings using the User Layouts menu.  This will save you from having to regroup your report each
time if you always want the same view.

Loading a saved layout
Select "Load User Layout" from the User Layouts menu.

Print

Columns: Hide/Display, Group, Sort, Filter,
Order

Select all rows

Clear selected rows

Expand groups

Unmatch records

Copy selected rows and columns to
clipboard (can paste into Excel)

Export

Help on button choices

5.3 Grouping data

Reports are only useful if they can be interpreted quickly and accurately.  It is both cumbersome and
error-prone to be forced to scroll through tens or hundreds of records looking for certain ones.  
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Bank Reconciliation allows you to group report data on many different fields to see a breakdown by
category.  

In Figure 1 (below), Report Creator is showing the Unmatched items (period sensitive) report, and the
data is grouped first by origin (Bank or G/L) and then by Period.  This means that all the records are
put into two groups, Bank or G/L.  Next, still inside the respective groups, each of the records is
ordered by Period.

To create or remove a grouping:

Creating or removing a grouping is as easy as dragging the column heading to the grey bar (to group)
or drag it back to the grid (to ungroup).  

Related Topics

See Commonly used reports to learn about popular reports.

5.4 Troubleshooting

My Reports do not show all the records that I was expecting.
I can see unmatched G/L checks on the 'All Records' report, but when I run an 'Outstanding
Check list' - they don't show up.

Please check your current period.  If you imported checks dated September 2010, but are running an
Outstanding Check List as of August, the checks will not show up on the report.

You can verify/change your current period by going to the Reports Menu (View, Export, Actions,
Current Period).  If you need to change the current period - click on 'Current Period'..
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5.5 Reconciliation Troubleshooting

Is your Reconciliation Report out of balance?

If so, please follow these steps to identify the transaction - and get back in balance.

When the system attempts to run the reconciliation report, it is really running two processes:

1. It first runs a report to make sure that your current period is balance (Ending Balance = Beginning
Balance + Net Activity).
If your current period is out of balance - you'll get the 'Red Screen' and be asked to re-enter your
ending balance.
Of course, if the issue is in the net activity, you should exit the report and add/delete/update your
current period's transactions.

If both the Bank and G/L are in balance, it then proceeds to the next process.

2. The system then runs the reconciliation report - which is a history to date report.  
If there is an out-of-balance, a transaction(s) in a prior period has been added, deleted or adjusted.
Note: With the introduction of our Stay-In-Balance lock feature - prior periods are automatically locked.
 
Check to see if transactions have been introduced circumventing our security (via SQL), or if a user has
unlocked prior periods.

If you cannot identify the entry, re-run the reconciliation report for earlier periods until it is back in
balance.  Therefore if November 2014 and earlier was in balance, and December 2014 and forward is
out of balance - investigate/make the entry for December 2014.

Once you identify the entry in the prior period entry that knocked it out of balance - please update.

Note: Depending on your version, the system may prohibit you from making the entry (Stay-In-Balance
lock).  

You'll then need to unmark the periods as reconciled - in order to make the entry.  
To do so: Run the 'Periods' report (View > All Reports > Periods).
Select/highlight the period.  On the Report sub-menu select Actions > 'Unmark Period as Reconciled'.  

Repeat this unmarking for the period containing the error - as well as all subsequent periods.
In the example, you would unmark December 2014 and all subsequent/future periods.

You can then make the correcting entry.
Note: In subsequent versions, we have blocked all activity to reconciled periods with our 'Stay in
Balance' feature - you may want to upgrade.

Once you have made the entry - re-run the Reconciliation Report for that period (ie. December 2014).  
Then re-run all subsequent periods.



Reference
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6 Reference

6.1 Accounts

Overview

An account is used to contain all data imported, stored, and used by Bank Reconciliation or Bank
Positive Pay.  Using an account organizes data around a logical point (for example, payroll records into
an account called "Payroll") and keeps it separate from the data from other accounts.  

Why not use the Sample account?

Bank Reconciliation and Bank Positive Pay come with a built-in account, Sample, which is used solely
to demonstrate use of the system. You should NEVER use the Sample account for your company's
account as it resets each time the program is started. This means that every time the program runs,
the Sample account has no data associated with it. You should create an account and always use it for
your data.  

Valid Account Names

You should give your accounts names that make sense in the context of the data.  For example, call the
account "Payroll" for payroll data. Calling it "Data Set A" is unintuitive and is likely to cause at best
confusion and at worst, erroneous imports.

There are only a few rules for account names.
1.  They can only contain letters, numbers and the underscore, no special characters or spaces.
2.  Do not start an account name with a number.
3.  Must be unique (cannot have multiple accounts named Payroll, for obvious reasons).
4.  You are allowed up to 255 characters for the name, but for practical reasons related to your use
and to internal 

storage, you should keep the name under 20 characters.

To learn how to create the account see Creating an account
To use a previously created account see Switching accounts
To delete an account, see Deleting an account

Treasury Software Copyright.

6.1.1 Creating an account

 
Creating the account

1. From the Main Screen, select File, then New Account.



72

BankRec                                                                                                                                                                                                                  © 2016 Treasury Software

Reference

The two choices are:
· Create an account + Add to catalog

By using this option, the Account Creation process will create a new account and add it to the local
catalog

· Add an existing account to your catalog
Select if the account already exists

By far the most common option is to simply create the account from scratch. Leave that selected and
click Next.

2.  You will now see this screen:
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Enter the name you wish to use for the account. Pick something that will help you distinguish the
account's meaning (for example, Payroll for a payroll account).  Bank Reconciliation will not allow
spaces in account names so  use the underscore (_) or internal capitalization to make the name clear.

Remember:
· Do not start an account with a number
· Keep the account name under 20 characters
· It must be unique from other account names

After entering, click Next.

3.  In Bank Reconciliation only, you will now see this screen:
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Select the accounting period for this account.  The most common choice is simply using months. 

Note:  You cannot change the period type once data is imported or entered into the period.

Click Next.

4.  You will now see this screen.
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The account has now been successfully created. Click Finish.

Related Topics

Switching accounts to learn how to move among accounts

6.1.2 Switching accounts

Overview

Switching accounts is necessary when you are using multiple accounts in Bank Reconciliation and you
wish to move from the current account to another.

Required

It is required that you have created at least one account. 

Note: The Sample account should never be used for live data.

Steps

Switching accounts is very straight-forward.  There are two ways to do it. For either method, you need
to be at the Bank Reconciliation Main Screen.
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1.  Select File, then the account you want to work out of.
If you are using a version prior to 2013 then click on Accounts on the lower left corner.

6.1.3 Deleting an account

Overview

Deleting an account should not be undertaken lightly. Any data imported under that account name will
be inaccessible.  Please only delete an account when you are sure the account data will never be
needed by Bank Reconciliation again (without having to be reimported).

Steps

1.  Select File then Delete Account.
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6.2 Definitions

6.2.1 Mapping Fields

Mapping is the process that translates your internal data field names to names with which Bank
Reconciliation is familiar. 

For information on the available fields, see the field definition. 

6.2.1.1 Amount

Amount

Usage:  Dollar amount of a transaction
Required: Yes (unless mapping Debit/Credit or Amount_Reverse_Sign)
Restrictions: Cannot map with Debit/Credit or Amount_Reverse_Sign fields

Amount is used when the transaction data represents both positive and negative numbers.  

For all data:
· Positive increases a balance
· Negative decreases a balance

Bank account balance and general ledger account balance are inverses of each other.  A transaction
that increases the general ledger balance decreases the bank balance and vice-versa. See Debit
versus Credit for more information.

6.2.1.2 Amount_Reverse_Sign

Amount_Reverse_Sign



78

BankRec                                                                                                                                                                                                                  © 2016 Treasury Software

Reference

Usage: Used when entire import reduces balance, but the amounts are absolute (positive)
Required: No
Restrictions: Cannot map with Amount, Debit/Credit, or Sign fields.

A common situation for using Amount_Reverse_Sign is when a bank transmits separate files for credit
and debit transactions, but all amount values are absolute.  

When imported as bank data, map the debit file using Amount_Reverse_Sign for the amount values, but
use Amount for the credit file.

For more information on meaning of debit and credit, see Debit versus Credit

6.2.1.3 BAI

BAI

Usage:  Used to determine sign in modified inter-bank BAI (Bank Administration Institute) files
Required: No
Restrictions: All data in Amount field must be positive. Do not use with Sign.

If choosing between the Sign field and the BAI field, use the Sign field as accuracy will be the same but
processing will be faster..

6.2.1.4 Check Number

CheckNumber 

Usage:  There are separate CheckNumber and Description columns (typically General Ledger). 
Required: Yes (can be turned off).
Restrictions: Do not use with CheckNumber+Description, CheckNumber+TrailingVoid, or LeadingVoid
+CheckNumber

Check number can be formatted internally as:
· Numeric e.g. 8524
· Prefaced with text information e.g. Check # 8524 or #8524 

If the field containing the check number also contains a void indicator, either leading or trailing, see 
LeadingVoid+CheckNumber or CheckNumber+TrailingVoid

See Turning off check number requirement for non-check based accounts.

6.2.1.5 Check Number + Description

CheckNumber+Description

Usage:  Typically used with Bank imports when the Description field also contains the check number
Required: No
Restrictions: Do not use with CheckNumber

This field is rarely used.  Some banks used to export check number and description as one field, but
seldom is that the case today.  Retained for backward compatibility, but in almost every case, you will
use CheckNumber.
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6.2.1.6 Description

Description 
Usage:  Textual description of the transaction.  Typically used with General Ledger imports to capture
vendor name or code.
Required: No
Restrictions: None

If the Description also contains the transaction's check number, see CheckNumber+Description

6.2.1.7 Date

Date

Usage:  A date in any Windows-compatible format.
Required: Yes 
Restrictions: None

By default, the system assumes you are using a date in the form MM/DD/YYYY.  This also includes
dates of form M/D/YYYY.  

If your data uses a different date format, see Changing the default date format.

6.2.1.8 Filter

Filter

Usage: Use to restrict import based on certain criteria (example: import data into different accounts
based on a certain field).
Required: No
Restrictions: Not necessary to map if only one account is present in data file.

Filter is used mainly with Bank data in situations where transaction records for multiple accounts is
recorded in one file.  By using Filter, it is possible to import the data into the proper Bank Reconciliation
account based on a filter on one field in the file.

For example, if a checking account ends 123 and savings account 456, can set the Filter text to be
123.  On the import, Bank Reconciliation will separate the data into the proper Bank Reconciliation
account.  

See Setting bank account number for more information.  

6.2.1.9 Matching_Field

Matching_Field

Usage:  Use when data has a corresponding field holding a unique identifier solely for purpose of
transaction matching
Required: No
Restrictions: None
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6.2.1.10 Sign

Sign

Usage: Used to hold the debit or credit text, typically for bank imports
Required: No 
Restrictions: Only use when all data in Amount is positive.  Can only map with Amount.

Sign is used when amount values are absolute and the sign is indicated in a separate field.  For
example, the file may have data similar to:

47.22 debit
68.19 debit
32.40 credit
101.80  debit

The first column would be mapped as Amount; the second column would be mapped as Sign.  

The Sign field is Bank-centric.  In other words, Bank Reconciliation will treat amounts associated with
"debit" as being negative.  

For more information on debit and credit related to sign, see Debit versus Credit

If your data uses indicators other than "debit" and "credit", see Changing debit and credit text  

6.2.1.11 Site

Site

Usage:  Used typically for depository accounts with MICR encoding on deposit slips
Required: No
Restrictions: None

Site adds an additional attribute for the system to use when performing Automated Transaction
Matching. 

 

6.2.1.12 Void Check Indicator

Void Check Indicator

Usage:  Used exclusively for importing check registers
Required: No
Restrictions: None

Map when importing a check register and the void indicator is in a separate column from the check
number.  By default, Bank Reconciliation uses a void indicator of "v" (or "V", case-insensitive).

If your void indicator is in the same field as the check number, see CheckNumber+TrailingVoid or
LeadingVoid+CheckNumber.

If you need to change the void indicator, see Changing void check indicator  for more information.
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6.2.1.13 CheckNumber + TrailingVoid

CheckNumber + TrailingVoid

Usage:  Used exclusively for general ledger data when the void indicator is appended to the check
number (e.g. 1234v)
Required: No
Restrictions: Only available on General Ledger imports

Commonly used when importing check registers, mapping this field will indicate to Bank Reconciliation
that voided checks will have the void indicator appended to the check number. For example,  data may
look similar to:

Figure 1 - Trailing Void Indicator

In Figure 1 (above), check 1860 is as voided check in the amount of 67.89.  The other 3 checks are
issued checks. The Check # field should be mapped as CheckNumber+TrailingVoid. Note: "v" is the
default void indicator. See Changing the void indicator.

Related

See LeadingVoid+CheckNumber if the void indicator prefixes the check number.

See Changing the void indicator to set the specific void indicator for your data.

6.2.1.14 LeadingVoid + CheckNumber

LeadingVoid + CheckNumber

Usage:  Used exclusively for general ledger data when the void indicator is prepended to the check
number (e.g. v1234)
Required: No
Restrictions: Only available on General Ledger imports

Commonly used when importing check registers, mapping this field will indicate to Bank Reconciliation
that voided checks will have the void indicator prepended to the check number. For example, data may
look similar to:

Figure 1 - Leading void indicator

In Figure 1 (above), check 1860 is a voided check in the amount of 67.89.  The other 3 checks are
issued checks. The Check # field should be mapped as LeadingVoid+CheckNumber. Note: "v" is the
default void indicator. See Changing the void indicator.
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Related

See CheckNumber if there is no void indicator in the same field as the check number.
See CheckNumber+TrailingVoid if the void indicator prefixes the check number.

See Changing the void indicator to set the specific void indicator for your data.

6.2.2 General Information

6.2.2.1 Debit versus Credit

For any account, a transaction either increases or decreases the account balance.  However, an
increase is not always a debit or always a debit. The context determines the meaning.

Bank General Ledger

Debit Decrease Increase

Credit Increase Decrease

Debit transactions include:
· Voided checks
· Deposits

Credit transactions include:
· Issued checks
· Withdrawals

For example, a file consisting solely of voided checks imported as general ledger data can be referred
to as debit transactions, but if imported as bank data, those same transactions are credit transactions. 

During the mapping process, you will determine what fields in the source file represent the dollar value
for the transaction. These will sometimes all be positive, even when they decrease the balance. You
must understand how each transaction affects the balance for that data set (bank or general ledger) in
order to determine which field is the right one.  Mapping the field improperly will lead to inaccurate
matching because the sign will be incorrect. 

6.2.2.2 Changing void check indicator

When importing a check register, both issued as well as voided checks are likely to be included.  By
default, the system will interpret a check number ending with a "v" to be a voided check e.g. 4523v
would indicate check # 4523 and it would be a voided check.  However, not all systems use the same
indicator.  Follow these steps to change the indicator for your data.

Select the Settings tab > Import,System tab > Import tab.

If you are using a version prior to 2013 please follow the next steps.
1. While working in the appropriate account, select File from the main menu
2. Select Options, then General.
3. In the corresponding textbox for "Void Check Indicator", type in your indicator.
4. Click Close.

The system will now use the indicator you inputted to determine voided checks for all imports into this
account.

Not sure how to change accounts? See Switching accounts.
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6.2.2.3 Changing debit and credit text

Some banks will send transactional data with all amounts as absolute (positive) values.  Alongside the
data will be a field indicating whether the transaction was debit or credit. 

For example, data could look similar to:

47.22 debit
68.12 debit
42.14 debit
98.11 credit

The first column would be mapped as the Amount field; the second column would be mapped as the
Sign field.  

By default, Bank Reconciliation will use "debit" and "credit" to represent those transactions as such.  

However, what if the credit used is "d" and "c"?  

Select the Settings tab > Import,System tab > Import tab.

If you are using a version prior to 2013.
1. Select File from the main menu
2. Select Options, then General
3. Under the Import tab, look for "Text for 'Debit' "
4. In its corresponding textbox, change "debit" to "d"
5. Follow same steps with "Text for 'Credit' " entry
6. Click Close

When working with your data, replace "d" and "c" above with the text for your particular situation.

6.2.2.4 Turning off check number requirement

Turn off check number requirement

Not all accounts are check-based.  For example, the concept of check number is meaningless for a
depository account.  By default, CheckNumber (or one of the fields that contains CheckNumber) is
required.  However, you can turn off this requirement. 

1.  From the Main Screen, select File, then General, then Options.
2.  Under the Import tab, find the option labeled "Check number mapping required?" Set it to "Off."  
3.  Click Close.

6.2.2.5 Turning off decimals in amount

Suppose your bank data resembles the following:
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Figure 1 - Amounts without decimals

In Figure 1 above, Bank Reconciliation will treat each of the amounts as a whole dollar value.  In other
words, Bank Reconciliation will handle check 1892 as being issued for the amount $42,793.00. 
However, that amount should actually be $427.93.  Follow these steps to turn on decimal periods. The
bank and general ledger can be set separately as you will see below.

Select the Settings tab > Import,System tab > Import tab.
Under the import tab:
a. For Bank data, set "Imported amounts need decimals - Bank" to "On" 
b. For General Ledger data, set "Imported amounts need decimals - G/L" to "On"

If you are using a version prior to 2013.
1. At the Bank Reconciliation Main Screen, Select File from the main menu.
2. Select Options, then General.
3. Under the Import tab:

a. For Bank data, set "Imported amounts need decimals - Bank" to "On" 
b. For General Ledger data, set "Imported amounts need decimals - G/L" to "On"

4. Click Close.

6.2.3 Options

Bank Reconciliation is incredibly customizable, from date formats and embedded check numbers to
custom imports and automated scheduling.  Taking advantage of some of these features involves
setting the appropriate options.

Required:
· You must be working in the appropriate account.  

Options are account-specific and will not care over to multiple accounts. This is good because it allows
you to keep them static for data that will always be formatted the same. However, you must take care
to change them in the correct account. 

Select Settings tab > Import, System > Import tab.

If you are using a version prior to 2013:
All these options are found  by:
1. Select File from the main menu
2. Select Options, then General

You will see Figure 1 (below). 



85

BankRec                                                                                                                                                                                                                  © 2016 Treasury Software

Reference

Figure 1 - Options dialog box

There are 7 tabs available:
· Import (currently selected)
· Match
· Reports
· System
· BAI
· Resume Startup
· Bank Code
· Custom

6.2.3.1 Import

The Import tab is selected by default when General Options is loaded. It looks like Figure 1 (below).
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Figure 1- Options dialog box (Import tab selected)

Below are all the options available under the Import tab. Click the link for more information.  Please
note: options can be set differently for bank and general ledger data.  The options below group
multiples into one link to save space. These will have an X where the option would be with the type
(bank, G/L) listed in parentheses and separated by semicolons. 

· Text for 'Check'
· Void Check Indicator
· Text for 'Debit'
· Text for 'Credit'
· Check Number Mapping Required?
· Date Mapping Required?
· Multi-line Check Format
· Imported amounts need decimals - X (Bank;G/L)
· Custom Date Import (CDI): X (Bank; G/L; CC)
· CDI: Source Format X (Bank; G/L; CC)
· CDI: Separator X (Bank; G/L; CC)
· CDI: Embedded Start X (Bank; G/L; CC)
· X - Daily Reconciliations (Bank; G/L)
· X Import contains: (Bank; G/L)
· X Import: Search for non-check dupes (Bank; G/L)
· X Import: Stop import or exclude on dupes? (Bank; G/L)
· X Import: Use multi-period warnings (advanced)  (Bank; G/L)
· Filter Import - X (Bank; G/L)
· SQL - Timeout (in seconds)
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· # X copy and paste (columns; rows)
· G/L Only: Suppress Void Indicator when embedded
· Text for Manually Added records
· Suppress void check warning on import
· Suppress prompt to show file after creation

6.2.3.2 Match

Enter topic text here.

6.2.3.3 Reports

Enter topic text here.

6.2.3.4 System

Enter topic text here.

6.2.3.5 BAI

Enter topic text here.

6.2.3.6 Resume Startup

Enter topic text here.

6.2.3.7 Bank Code

Enter topic text here.

6.2.3.8 Custom

Enter topic text here.

6.3 Periods

Periods

All Treasury Software products have a built in calendar - called 'Periods'.

Periods are typically the end of each month. If you run the 'Periods' report (View > All Reports >
Periods), it might look like: 
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Adding / Changing Periods
 
Changes to the Period table are permanent - and incorrect changes can render the
account useless.  Make a backup prior to modifying your periods.

To modify your periods, navigate to Settings > Maintenance > Periods > Change and Update Periods.
All Period changes start at this screen.
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Rule 1 - Golden Rule
Never change (or delete) a period which contains data - or any period before it.

Therefore, if you have transactions in the period March 2015 - you can only change
periods April 2015 and after.

For example, you are currently using monthly periods (default) and you want to change to a weekly
basis.
First, run a report to view the latest transaction. For this example, it would March 29, 2015.  Since the
current periods are monthly - that means only periods after March 31, 2015 can be updated (deleted/
added).

Rule 2 - Leave extra periods at the beginning.
You must have at least 6 periods prior to the first transaction date (for reports) and for the
prior period balance.

Therefore, if you plan on importing data starting January 1, 2015 - your first period (if months),
should be July 2014.

How to change periods - if you haven't imported any transactions to the account
(easy)
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You can either:
Manually
--Select all of the periods on the right side of the above image, then click 'Delete a Period'.
--Then manually on the left side of the above image - edit the date and then click 'Add a Period'.  Note:
Start with the earliest period to add.

Importing
--Click on the link in the image above labeled 'Change Periods from Months and/or import your list'
This will open the form below.

Use this form to import a list of periods.  Since you're just starting out and you have no data in the
account - select 'Replace'.  The replace option will take care of deleting all of your current periods.

Period Import screen

 

How to change periods - if you already have data in the account

First, determine the last period which contains data.  For example, let's say that March 2015 is the last
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period with data in it.

Period Maintenance Screen

You can either:
Manually
--On the Period Maintenance Screen, select the periods to delete, then click 'Delete a Period'.  For this
example, you would only click periods April 2015 or later.
--Then manually on the left side of the above image - edit the date and then click 'Add a Period' -
adding the periods starting with the earliest period.

Importing
--Delete the periods as noted in the 'Manual' section above. Note: We need to delete the periods here
(versus the earlier example), because we won't be using the 'Replace' option in the next step.
--On the Period Maintenance Screen, click on the link labeled 'Change Periods from Months and/or
import your list'
This will open the Period Import screen.  Create a list of periods (in this example, your periods should
start after March 31, 2015).

Use this form to import a list of periods.  Since you're keeping the list of periods March 31, 2015 and
prior - select 'Append' (not Replace). Note: Strike-through font on purpose.

Run a Period report to check you work (View > All Reports > Periods), 

6.4 FAQS

See below for FAQS
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6.4.1 How many "accounts" are needed?

How many "accounts" need to be created in the software?

Golden Rule: An account should be created for each reconciliation report needed. Ex: A company has
two bank accounts, checking and savings. Each account is separate and needs a reconciliation report
containing only that account's information. In this scenario, two accounts in Bank Rec will be needed.  

To Create an Account

Click File>New Account to create a new account.

Select the option to “Create an Account and Add it to your Catalog” and click Next.
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Enter a name for the account.  This name is strictly internal and should help you identify the purpose of
the account.  For example, if this account is an operating account, you might call it "Operating".  After
the name is entered, click Next.
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Congratulations! You have finished creating the account.  Click Finish to begin using this account.  

6.4.2 I don't have a "Bank" or "GL" file-can I still use Bank Rec?

I don't have a "Bank" or "GL" file-can I still use Bank Rec?

Yes. 

Bank Rec can match any two pieces of information using the mapped criteria. "Bank" and "GL" are the
most common. 
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To map:
1. Click on the red header. 
2. In the dropdown, select the appropriate entry

The header will turn green and the field name will be displayed inside. 

To unmap:
1. Click on the green header
2. In the dropdown, choose "Select..."

The header will turn red and the field name will be removed.

How do I know which field names to use?

Look at the data in the movie above.  Each column is labeled with internal field fields.  Of these, five
correspond directly to a Bank Reconciliation field while the others can map to a text field if you need to
retain them.

Internal
Field

Maps As Bank Reconciliation Field

Date Date

Check
Number

CheckNumber
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Amount Amount

Transaction
Type

Description

Bank ID Text1

Currency Text2

Account ID Text3

6.4.3 Have multiple bank accounts on one file, how do I filter them?

Have multiple bank accounts on one file, how do I filter them?

Bank Rec has a filter option for both the Bank and the GL. 

From the Settings Menu select Import, Matching, System. On the Import tab, scroll to the Filter
Option. 

Enter the filter criteria. 

Proceed to import and map the data. Note, the filter criteria column must be mapped using "Filter" in
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order for this function to work properly. 

6.4.4 Does Bank Rec include template files?

Does Bank Rec include template files?

Yes.

When Bank Rec is downloaded a tutorial folder is created in the C:\Users\Public\Treasury Software
\Tutorial. 
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This folder contains both sample Bank and sample GL data, meant to help with mapping information
correctly. 

6.4.5 How do I change/add periods?

Changes to the Period table are permanent - and incorrect changes can render the
account useless.  Make a backup prior to modifying your periods.

To modify your periods, navigate to Settings > Maintenance > Periods > Change and Update Periods.
All Period changes start at this screen.
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Rule 1 - Golden Rule
Never change (or delete) a period which contains data - or any period before it.

Therefore, if you have transactions in the period March 2015 - you can only change
periods April 2015 and after.

For example, you are currently using monthly periods (default) and you want to change to a weekly
basis.
First, run a report to view the latest transaction. For this example, it would March 29, 2015.  Since the
current periods are monthly - that means only periods after March 31, 2015 can be updated (deleted/
added).

Rule 2 - Leave extra periods at the beginning.
You must have at least 6 periods prior to the first transaction date (for reports) and for the
prior period balance.

Therefore, if you plan on importing data starting January 1, 2015 - your first period (if months),
should be July 2014.

6.4.6 How do I change the company name on Reports?

How do I change the company name on Reports?

To change the company name that appears on the top of printed reports go to the Settings Menu--
>Import, Matching, System--> Reports
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6.4.7 What do I enter into the Reconciliation Report?

The Reconciliation Report is a check on the information that has been imported into Bank Rec. 

To run the report click on Reports--> Reconciliation Report

On the window that opens, check or change the Period Ending date by clicking on the drop down
menu. 

Next enter the Bank- Ending Balance as per the Bank statement. 

Enter the G/L-Ending Balance as per company policy. 

Click Run Report. 
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6.4.8 How do I see the records that Bank Rec Matched?

Run the "Matched Records report" to view the records Bank Rec automatically matched, or records
that were manually matched. 

From the Reports menu choose "All Reports"

From the Report list, chose "Matched Only" and select the date range for your report. Hit Run.
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